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Dear students, 

The infinite possibilities of Information and Communication Technology 
have made many things that seemed impossible possible. The ICT textbook 
for Standard 8 has been designed to guide you into the world of technology,  
facilitating self-learning, doubt clearance and knowledge construction.

Using this book, you can practice word processing, spreadsheet and  
presentation software and engage in various activities. In addition, by using 
block coding, you can create computer games and learn the fundamental  
principles of machine learning. The history and various services of the  
internet are also explored in this textbook.

The textbook also includes resource creation using multimedia tools, such 
as digital painting, video editing, and music composing. Let this ICT text-
book help you acquire new knowledge and enhance your creative abilities 
by effectively using digital technology in the learning process. 

                      			   With regards,

	 Dr. Jayapralash R.K. 
Director
SCERT
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The Talking Walls
Walls have been used as canvases for communication since ancient times. 
A timeless and universal art form, mural painting has been one of the 
cornerstones of human expression and communication throughout history.

Wall paintings, with roots in ancient civilizations such as Egyptian tomb 
paintings and Greek frescoes, reflect the cultural, social, and political 
contexts of their time.	

Beyond the aesthetic appeal of visual art, wall painting plays a significant 
role in transforming public spaces, conveying social messages, and fostering 
community engagement. From simple designs to elaborate and intricate 
murals, artistic creations on walls serve as platforms for personal expression 
and storytelling.

Chapter 1

Colourful Images on the Wall 
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KRITA

Krita is a free software used 
for digital drawing and 
painting.
Some of Krita’s special 
features include a highly 
useful brush engine, layer 
management, and animation 
tools.
It can be used on various 
operating systems, including 
GNU/Linux, Windows, and 
macOS.

The Headmistress mentioned in the school assembly that 
everyone should beautify and maintain their classrooms as 
much as possible. Hima and her friends took this seriously. 
After detailed discussions in the class, they decided to paint a 
beautiful picture on the back wall of their classroom.

What if this were your classroom? What would you like to 
paint on the class room wall?

	� Trees filled with colourful flowers

	� Planets and stars

	� A bird perched on a tree branch

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................

Among these you, can an idea that you think is good and start 
drawing. Decide which one you want. Hima and her friends 
decided to draw a bird sitting on a tree branch.

The Magic of Digital Drawing

There are many artists in our area who beautifully write and 
draw on walls, banners, and canvases. They can easily transfer 
their ideas directly onto the canvas.

It is better to first prepare the picture you want to draw.  What 
if you use a computer to prepare the image?

If an image editing software is used to create the picture, it 
can be edited and modified both during and after the drawing 
process.

Last year, we became familiar with an image editing software 
called Krita. It is one of the best digital painting tools, offering 
many features. Let's create a design in Krita to paint on our 
wall.

Open your computer and create a new project file in Krita.
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To create a new file in Krita

	� Click New File (Ctrl+N) under Start in the window that 
appears when Krita is opened (a new file can also be created 
by File – New). 

	� Specify in the window the required width and 
height of the canvas.

	� Here we can use width and height proportional to the 
dimensions of the wall.

Let's Get Familiar with Krita's Interface

Haven't you created a new file in Krita?

The Krita window (Figure 1.1) is organized into different sections, 
such as the canvas, the toolbox, and various dockers.

Our artwork will be created on a canvas that we have chosen at 
an appropriate size. We can zoom, rotate, and pan the canvas as 
needed while we are working.

The toolbox on the left contains brushes, tools for creating custom 
shapes, and various selection tools.

Fig. 1.1 Krita - Main Window
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The dockers on the right include a color selector and layer 
manager that help with easy image manipulation tasks.

Let's take a closer look at the tools and dockers in Krita.

Use the tools you are familiar with from the toolbar to draw 
some lines on the canvas.  Along with that the use of each tool 
should be identified and recorded in the table below. 

No. Tool Usage

1 Brush Tool Freehand drawing and painting can be done

2 Fill Tool (Bucket)

3 Text Tool

4 Move Tool

5 Selection Tool

6

Table 1.1 Usage of Tools in Crita

A Bird on the Branch
It is a clear dawn. A solitary tree stands alone. A small bird sits 
on its branch. The gentle presence of the bird breathes life into 
the stillness of the scene, adding a sense of quiet vitality.

Let's see how to draw such a scene using a computer. 

What elements need to be drawn for this scene?

1.	 Branch of the tree - The branch of the tree will become        
beautiful when its leaves are drawn together.

2.	 Bird - The body parts of the bird can be drawn                      
separately and then assembled.

3.	 Matching background.

When drawing a picture, instead of recreating the scene exactly, 
we should capture the experience that the scene creates within 
us on the canvas. Colours of choice can be used.
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It is better to draw each element of our picture in separate 
layers. That way, as we understood in the previous class, it will 
be easier to make the necessary improvements.

The Branch for the Bird to Perch on
Let’s start by drawing a branch. There is no fixed shape or size 
for branches, so we can draw a branch according to our own 
imagination.

After creating a new layer in Krita, draw the branch on it. You 
can make use of the tips given below.

Layer can be created
To create a new layer, click 
the + button in the Layer 
Docker located on the 
right side of the screen. 
A new transparent layer 
named Paint Layer 2 will 
appear at the top of the 
existing layers. You can 
double-click on this name 
to rename the layer.Fig. 1.2 Layer Docker

Drawing the Tree Branch
	� Create a new layer and name it "Branch."

	� Using the Brush Tool (B), draw the tree branch.  

(Alternatively, you can use the Bezier Curve Tool to 
draw the outline and then use the Fill Tool (F) to add the 
necessary colours to the branch.)

	� Scroll the mouse wheel to zoom in and out of the canvas, 
then take the required time to complete the drawing of the 
tree branch (an example is shown in Figure 1.3).

	� By changing the size and colour of the brush, you can 
mark the rough spots on the tree trunk. To  remove any 
unnecessary lines and refine the edges, you can use the 
Erase Tool (E). Later, you can try using lighter colours 
for highlights and darker  colours for shadows on the 
branch.
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Fig. 1.3 Model of the Branch

The Bird in Lines
There won't be anybody who hasn't drawn a picture of the 
bird. Why not try sketching a bird from our imagination for a 
painting on the classroom wall?

To make drawing easier, let's first break the bird down into 
its different parts—head, eyes, beak, body, wings, and legs. 
Then, we can draw each part separately and put them together. 
It's best to draw each body part on separate layers for better 
accuracy.

Let's Draw a Bird
1. 	 Head, Body, and Beak of the Bird

	 Those who can skillfully draw the bird's body parts 
using the Brush Tool can do so. If that feels difficult, 
you can first draw simple geometric shapes to construct 
these parts more easily. To do this:
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Fig. 1.4 Some Steps of Drawing a Bird

	� Use the Ellipse Tool to draw the bird's head as a circle 
and the body as an oval. (Figure 1.4)

	� Slightly rotate the ellipse slightly using the Transform 
a layer or a selection (Ctrl+T) tool.

	� Then, use the Bezier Curve Tool to complete the 
shapes of the body, head, and beak.

	 When using the Bezier Curve tool, if you are drawing a 
non-closed shape, you can simply double-click to end 
the line.

2. 	 Wings and tail

	 Create a new layer and use the Bezier Curve Tool to 
draw the wing. If needed, you can temporarily hide the 
"Branch" layer while drawing.

	 On a new layer, draw the bird's tail. You can use the 
Line Tool, Poly Line Tool, or Bezier Curve Tool for this. 
(Figure 1.4)

Erase any unnecessary lines using the Eraser Tool.

3. 	Legs
	 You can draw the bird's legs using the Brush tool. For 

this, adjust the colour and size of the brush appropriately. 
Since the bird is sitting on a tree branch, it is best to 
make the tree branch layer visible while drawing the 
legs.

Drawing with the
 Brush Tool

Select the Brush Tool (B) and 
choose a suitable brush from 
the Brush Preset Selector 
that makes it easier to draw 
the tree branch. (Textured/
Natural brushes like 
Charcoal, Ink, or Dry Brush 
can also be used.) Next, 
select a preferred colour 
for the tree branch from the 
Colour Selector. Adjust the 
brush size as needed and start 
drawing.
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Ellipse Tool
	� The Ellipse Tool is used to 

create perfect circular or 
elliptical shapes in Krita.

	� From the toolbox, select the 
Ellipse Tool, click on the 
canvas, and drag to form 
an oval. To create a perfect 
circle, click on the canvas 
and start drawing, then hold 
down the Shift key while 
completing the shape.

	� To change the size or 
curvature of the oval, use 
the Transform a layer or a 
selection (Ctrl+T) tool, and 
you can adjust it using the 
handles that appear around it.

You've drawn the outline of the bird. Now let's colour it.

Don't forget to save the file after each activity. Krita projects are 
saved in a file format with the extension .kra.

A Multi Coloured Bird
We often see birds in many different colours. There are also 
multicoloured birds. Try adding your favourite colours to the bird 
you've drawn to make it more beautiful. You can use appropriate 
tools like the Brush, Fill Tool, and Gradient for this purpose.

To Add Colour to the Bird
	� Select the appropriate colour from the Foreground     	

colour selector.

	�  Then, use the Brush Tool to add colour (Adjust the    	
brush size and opacity as needed).

	� You can also use the Fill Tool (F) to add colour to         	
closed shapes.

Fig. 1.5 After Colouring the Bird.

4. 	Make the Lines Natural
	 By removing certain parts of the lines and merging the 

drawn areas with flowing lines, the bird will appear more 
natural.
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Leaves, a Tree full of Leaves
Trees full of leaves are always a refreshing sight. How about 
adding full leaves to our tree too? Try to see if you can draw 
leaves on the branches of the tree without changing the focus 
of the line. You can also draw leaves using the preset stamp 
brush.

The Gradient Tool can be 
used to create a design by 

blending two colours.

To DrawLaves Using a Preset Stamp Brush

This is the process of drawing a single leaf, then converting 
it into a preset stamp and cloning the remaining leaves. To 
do this:

	� Draw a leaf using the Bezier Tool, on a new layer.

	� Apply colour to the leaf.

	� Now, to convert the drawn leaf into a preset stamp,

	� Hide all other layers except the one with the leaf drawn 
on it. Then use a selection tool (e.g. Rectangular) to 
select the leaf we drew. 

	� Select the Edit Brush Settings → Predefined Predefined 
tab above the canvas.

	� In the window that opens when you click on the Stamp 
below, name the new stamp Leaf and save it.

	� With this, the preset stamp brush is ready. Now you can 
load this brush, adjust its size, and draw a leaf. When you 
click and drag this brush, clones of the leaf are created.
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Create a new layer and draw the leaves around the tree branch.

Right-click on the canvas to open the Pop-up Palette, where 
you can adjust the Angle to set the orientation of each leaf.

Fig. 1.7 Leaves Using Preset Stamps

Fig. 1.6 Creating a Preset Stamp
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A Background that can be Used to Make a Visual 
Experience
A well-designed background breathes life into any artwork, 
elevating it to a whole new visual experience.

A well-crafted background can effortlessly draw the viewer’s 
attention while highlighting the importance of the main subject. 
By using design techniques that focus on simplicity, such 
as subtle gradients, textures, blurred elements, and abstract 
patterns, the main subject can be made more visually appealing.

Consider what kind of background would complement the 
bird on your branch. Using the suggestions provided, create a 
background that enhances your artwork.

Creating the Background

	� Create a new layer named "BG" and place it at the bottom of all other layers.

	� Use appropriate selection tools (e.g., Freehand Selection Tool) to select the desired areas 
on the canvas or create shapes.

	� Choose a suitable colour and apply it using the Fill Tool.

	� Try adding a setting sun as part of the background for the bird (see Image 1.8).

Fig. 1.8 When the Background is Added
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Save & Export
In Krita, the project file is usually saved at every stage of progress. 
The completed artwork can be exported into various common 
image file formats (JPG, PNG, Web, etc.).

The created image (Figure 1.9) can be exported to any image 
file format that you are familiar with and saved.

My Happy Classroom
Seeing the artwork we created displayed in our classroom 
every day is truly a delightful experience.

How do you plan to recreate the image of the bird sitting on 
the tree branch, drawn using the Krita image editor, on the 
classroom wall?

This can be done in two ways. Choose the method that suits 
you best.

Fig. 1.9 When the Picture is Finished
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Let's Assess

 	 What is the default file format for saving projects in Kria?

	 a) .psd                         	 b) .kra

	 c) .png                        	 d) .jpg

From Computer to Wall

1. Using our class projector
	� Using the classroom projector, project the image created on the computer onto the 
wall.

	� Ensure that the projection is at the desired size on the wall.

	� Now, trace each part of the image onto the wall using a pencil. Make sure to stand in 
a position where the projection light is not blocked while doing this.

	� Once the tracing is complete, turn off the projector and finalize the outline of the 
image.

2. Take a printout of the line and mark the grid on it.
	� We can take a printout of the picture we drew in Krita and mark a grid on it. The 
image with the grid marks can also be printed.

	� Create a proportional grid on the wall using a pencil and scale.

	� Then, carefully transfer the image onto the wall.

The next step is to add colour to the outline  drawn on the wall.

	� Prepare the necessary paints, paint brushes, rollers, trays, 
etc.

	� Start painting according to the outline you drew earlier. 
Ensure the desired result is achieved by combining the use 
of brushes and rollers.

	� Sometimes you will have to mix different colours to get the 
desired colour. 

	� Once the main painting is completed, add details and textures 
using small brushes.

Now, try using the techniques we've learned to make your 
classroom more beautiful.

Before you start drawing, 
don't forget to clean the 
wall and apply primer.
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Extended Activities
1. Draw a cartoon character you are familiar with using Krita.

2. Prepare the figure below (Lady Bug) in Krita.

3. Draw and paint a simple nature scene in Krita.

4. Create a New Year's greeting card in Krita

5. Draw a penguin in Krita.



	 What is the most commonly used tool for drawing freehand lines in Krita?

	 a) Fill Tool 		  b) Transform Tool   

	 c) Brush Tool    		  d) Gradient Tool

	 In drawing software, which feature lets you perform operations on specific elements of a 
drawing without affecting the rest of the image?

	 a) Layers			   b) Masks  

	 c) Groups    		  d) Brushes
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“Journeys are the best teachers of man”

This year’s school study tour is to Ajanta-Ellora, a long-awaited sight for us. The journey 

lasts five days. Our group consists of 45 students and 7 teachers. We traveled by train to 

Aurangabad, had breakfast there, and then proceeded to Ellora by a hired bus. Ajanta-Ellora 

is a visual treat that everyone should see at least once in their lifetime. Even today, these 

sites are considered gems of Indian history and remarkable examples of artistic expression. 

Ajanta and Ellora are included in UNESCO’s World Heritage list.

Diya is excited about the study tour from school. When she 
returned after visiting the Ajanta Ellora caves, the teacher asked 
her to prepare a detailed travelogue. The best travelogues will be 
compiled into books and kept in the library. The travelogue needs 
to be typed on the computer, formatted, printed, and submitted. 
For this, she is working on preparing the travelogue in a word 
processor.

Chapter 2

Page Designing in a Word Processor
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Let’s Type in Malayalam

Don't you have a similar situation? Malayalam typing and 
page setting are required when preparing travelogues, seminar 
papers, project reports, and documenting school activities.

How can documents like the one mentioned above be made 
attractive by setting up the page and layout in a word processor?

Some parts of the travelogue prepared by Diya are provided 
in our computer's School_Resources folder under the name 
ajanta.ott. Let's open this file in LibreOffice Writer and try 
adjusting the page layout in an attractive manner.

We have already learned how to set the keyboard language on the computer to Malayalam 
and type using it. Let us recall them. Using the diagram of the Malayalam keyboard 
layout in Figure 2.1, let us try typing the words given below in LibreOffice Writer.

അക്ഷരംം            നൂൂറ്റാാണ്ട്്     	    പേ�രാാല്‍        	 തൈൈമാാവ്്     	താാഴ്്വാാരംം

ഓടക്കുുഴല്‍         മനുുഷ്യയൻ   	    മൺപാാത്രംം		  ഋഗ്വേ�േദംം    	 സബ്്വേ�

Fig. 2.1 Malayalam Inscript Keyboard Layout

Open the file (ajanta.ott) and type the quote "മനുുഷ്യയനെ� 

പഠിിപ്പിിക്കുുന്ന ഏറ്റവുംം� നല്ല അധ്യാ�ാപകരാാണ്്  യാാത്രകള്‍" at the 
top of the page. Then press Ctrl+S, give it a filename and don't 
forget to save the file.

Did you change 
the Keyboard 

Layout to 
Malayalam?
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Table 2.1 Character Formatting Techniques in LibreOffice Writer

Practice Typing
Typing accurately and quickly is a skill that we need to develop 
through practice. There are several software programs available 
for learning typing scientifically, including KTouch and Tux 
Typing.

Different Forms of 
Letters

Everyone's handwriting 
is unique. Different font 
styles are available to make 
this possible in digital 
documents. The names 
of some Malayalam fonts 
installed on your computer 
are given below. Open Writer 
and try using these fonts to 
observe the difference in the 
letters.

Malayalam Fonts:

	� Anek Malayalam

	� Thumpapoo

	� Gayathri

	� Keraleeyam

	� Rechana

	� Noto Serif Malayalam

You have saved the file with a quotation. Now, what else can be 
done to make this document more attractive?

	� Font style, size, and colour can be changed.

	� Spacing between lines can be adjusted.

	� Spacing between paragraphs can be adjusted.

	� Background colour and a border can be added to paragraphs.

	� ...............................................................................................

	� ...............................................................................................

You have already learned from previous classes how to choose 
font styles and apply size, colour, and alignment to text.

Some formatting techniques for fonts in Writer are listed in 
Table 2.1. Arrange them in the correct order. If needed, open 
Writer and check them.

Activity Formatting technique 
to be used

Changing the font to Noto Serif Malayalam Font Color

Changing the font size to 13 pt Align Center

Aligning the heading to the centre Font Name

Changing the font colour to blue Font size

Let’s adjust the font style, size, colour, and heading alignment 
in our document according to the formatting instructions given 
in the table.
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What other things can be done, besides text formatting, to make 
the document more visually appealing? Examine textbooks 
and magazines to find out.

Make the Paragraph Attractive
Adjusting the spacing between paragraphs, line spacing, margin 
distance, borders, and background colour makes the paragraph 
more attractive and improves readability.

Using the Paragraph option in the Properties window of 
LibreOffice's sidebar, these adjustments can be made (Figure 
2.2). The spacing between paragraphs should be adjusted first. 
Give it a try!

Fig. 2.2 Paragraph Formatting in the 
Properties Window

To Adjust the Spacing between Paragraphs

	� Select the paragraph (or click on the paragraph).

	� Click the Increase Paragraph Spacing tool in the Spacing 
section of the Paragraph panel in Properties (Figure 2.3).

	� This sets the spacing between paragraphs to 0.10 cm.

	� To precisely adjust the spacing above and below paragraphs, 
enter the desired values in the Above Paragraph Spacing 
and Below Paragraph Spacing boxes.

Fig. 2.3 Paragraph Spacing

Line Spacing	
Now we have adjusted the spacing between paragraphs. How 
would you adjust the spacing between lines within a paragraph? 
To do this, click on Set Line Spacing in the Spacing section 
of the same window (Figure 2.4). Set the spacing to 1.15 and 
observe the changes in the document.

Paragraph Indenting
To improve the formatting of the document's content, the 
margin spacing should be adjusted appropriately

Similarly, to distinguish the beginning of paragraphs, the 
spacing between the first line and the margin should be set 

Fig. 2.4 Line Spacing
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differently from the other lines. This process is generally 
known as indenting. Try using the Before Text Indent, After 
Text Indent, and First Line Indent options in the Paragraph tab 
to make these adjustments.

To Adjust the Distance from the Margin

	� Select the paragraphs that 
need spacing adjustments.

	� In the Paragraph panel, 
under Indent, adjust the 
Before Text Indent, After 
Text Indent, and First Line 
Indent as needed. In the 
example shown (Figure 2.5), 
Before Text Indent is set 
to 0.40 cm, and First Line 
Indent is set to 1.30 cm.

Fig. 2.5 Paragraph Indenting

Content with More Clarity
Some information in the document you are preparing will need 
to be presented in a different way from others. This can be 
highlighted using bullets, background colour, and borders.

If the names of the major caves in Ellora and their specialities 
are presented within a border with a background colour, readers 
can easily find the relevant details. What if this information 
is also listed using bullets? Wouldn't that help readers clearly 
understand the key features of the major caves?

In the document provided to you, give a background colour 
and border to the paragraph that explains the main caves of 
Ellora and their features. For this, you can use the Paragraph 
option in the Format menu.

After completing the activity, you should also note down the 
sequence of activities in your notebook.

Bullets can be 
used to list 

important things.
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Adding Background Colour and Border to Paragraphs
	� Select the paragraph.

	� Then select  Format →Paragraph.

	� In the window that opens, open Borders (Figure 2.6).

	� Set Line Arrangement, Line Style, Colour and Width as required.

	� Set the values in Padding to adjust the distance between the text and the border.

	� To get different spacing from all four sides, simply uncheck Synchronize.

	� Use the Color option in the Area tab to add a background colour to the paragraph.

Fig. 2.6 Paragraph Formatting Window

Now, check the toolbar to identify the tool needed to format 
this paragraph as a bulleted list. Then, arrange the content as 
shown in Figure 2.8.
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Displaying Content as a Bulleted List

	� After selecting the content that needs to be 
formatted as a bulleted list, click on Toggle 
Unordered List.

	� Clicking the Arrow next to Toggle 
Unordered List will display more bullet 
styles (Figure 2.7).

	� Clicking More Bullets will open the Bullets 
and Numbering window, where you can 
select the appropriate bullets.

To remove the bullets, select the text and click 
the same tool again.	  

Fig. 2.7 Bullet Styles

Fig. 2.8 When the Content is Arranged in Bullets

Major caves of Ellora with their names and brief features:

♦	Cave 10 (Vishvakarma) – A large stupa of Buddha is seen here. 

♦ Cave 11 (Do Thal) – A monastery (vihara) with two levels. 

♦	Cave 12 (Teen Thal) – A three-level vihara with multiple Buddha images 

♦	Cave 15 (Dashavatara) – A vihara with sculptural depictions of Vishnu's and Shiva 

♦	Cave 16 (Kailasa Temple) – A monolithic rock-cut temple dedicated to Shiva, 

♦	Cave 21 (Rameshvara) – A cave famed for beautiful and intricate carvings 

♦	Cave 29 (Dhumar Lena) – A cave situated near the waterfall Elephanta.

♦	Cave 30 (Chhota Kailasa) – A smaller version of the Kailasa Temple

♦	Cave 32 (Indra Sabha) – A Jain cave with stunning carvings 

♦	Cave 33 (Jagannatha Sabha) – Another Jain cave, known for its intricate sculptures 
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Presenting Data in Table Format
In the document being prepared, some information may need to 
be presented in table format. Now, use the Insert Table option 
to create a table in the document, including details such as the 
different travel routes to Ajanta and Ellora Caves and other 
relevant information.

To Insert a Table into Writer
	� Place the cursor where you want to insert the table, and 

then click Table →  Insert Table.

	� In the window that opens, enter the number of rows and 
columns, and then click Insert. (Figure 2.9)

Fig. 2.9: Window for Inserting a Table

Make the Table Attractive
There are several options to make the table attractive, such as 
adjusting the size of cells, background colour, row, column, 
border colour, and text alignment.

If the table Tool box is 
not visible, go to

 View → Toolbar →Table 
and check it.
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The size of rows and columns in a table can be adjusted using 
the mouse. When the mouse is moved to the intersection of two 
columns, the pointer changes to a double-headed arrow. 	

Clicking and dragging allows the column width to be adjusted 
as needed. Similarly, the row height can also be adjusted in the 

Selections in Various 
Ways

In word processor software, 
text can usually be selected 
by dragging the mouse from 
the first letter to the last letter. 
However, there are other 
ways to do this.
Placing the cursor over a 
word and double-clicking 
selects the word. Try clicking 
three times in a row and see 
what happens!

Tools Usage

Rows Above

Columns After

Merge Cells

Center Vertically

Border

Border Color

Table Cell Background Color

Table 2.2 Table Formatting Tools

Hasn't you made the list attractive using the tools? Don't forget 
to save the file.

Name on Every Page
Should the document pages have a common structure, even if 
they are different? For example, in a textbook, have you noticed 
that the page number, book title, unit name, and class appear 
repeatedly at the top and bottom of every page? Items that need 
to be repeated on every page are added using Header and Footer 
techniques. 

Most tasks performed using word processor software can now 
be done online. Documents created this way can be printed and 
saved in various formats. Online platforms for this include Google 
Docs, Microsoft Office 365, Dropbox Paper, and Zoho Writer.

If you type using   
 Text Boxes you can 

place them anywhere on 
the page (even above the 

pictures). 
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To include Header and Footer on the Page

	� Clicking at the beginning of the document page displays the message Header (Default 
Page Style) on a blue background. (Figure 2.10)

	� Click on it and include the name of the travelogue 
as the header. [The header can also be inserted by 
clicking

[Insert → Header and Footer → Header → Default 
Page Style].

	� In this way, click at the end of the page and insert 
the page number as a footer..

Fig. 2.10 Include the Header

Online Documents

Most tasks performed using word processor software can 
now be done online. Documents created this way can be 
printed and saved in various formats. Online platforms for 
this include Google Docs, Microsoft Office 365, Dropbox 
Paper, and Zoho Writer.

Wasn't the travelogue title and page number added to every 
page? What if different headers/footers are needed for the left 
and right pages?

When you click on Header (Default Page Style) and select 
Format Header, in the window that opens, just uncheck the box 
next to Same content on Left and Right Pages under Header in 
the Header tab.

The included header and footer can be made more beautiful 

using formatting techniques.
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Using Only the Keyboard

Some tasks can be performed using only the keyboard. Check the lists in the menu bar to find the 
keyboard shortcuts for these actions and complete Table 2.3. 

Activity Shortcut Activity Shortcur

To Copy Ctrl+C To Select All Ctrl+A

To Cut To Save

To Paste To Undo

Table 2.3 Keyboard Shortcuts

Convert Document to PDF
The travelogue has been formatted and made attractive. Now, 
what if it needs to be printed? To ensure that the layout remains 
unchanged and fonts are displayed correctly when opening 
or printing the document on another computer, it should be 
exported to PDF format and saved.

How can our travelogue be converted to PDF?

To Export as a PDF Format
	� Click, File → Export As → Export As PDF.

	� In the window that appears, choose the suitable Range 
option.

	� Click the Export button.

	� Select the location where you want to save the file, enter a 
filename, and then click Save.

Using all the familiar techniques learned, create a travelogue 
about a journey you have taken. Enhance it by adding images 
and beautifully formatting the pages. Open the PDF file on a 
computer with a printer, print it, and submit it to the teacher.
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Text Input in Other Languages
What if you want to type in 
other Indian languages as well 
as English and Malayalam on 
your computer? The keyboard 
layout indicator on the top 
panel of your desktop currently 
has English and Malayalam 
keyboard layouts. To include 
another language on your 
keyboard, you need to do a few 
more settings. For that,

	� Open Settings →Keyboard. 
(Figure 2.11)  

	� Click the Add (+) ign below 
the current keyboard layouts 
in Input Source.

Let's Print

Before printing a document, we can preview how the printed output will look in the writer. 
For this, simply click on Print Preview in the File menu. To close the preview, click on Close 
Preview. To print, go to File → Print , select the Printer from the window that appears, and 
click Print.

Fig. 2.12 Add an Input Source

Fig. 2.11 The Window for Adding a Keyboard

	� From the Add an Input 
Source window that 
appears, select the required 
language.

	� Click More here to select 
Hindi (Figure 2.12).

	� Click Other at the end 
of the list of languages. 
(Figure 2.13)

	� Select Indian and click 
Add.

Fig. 2.13 Language Search Window
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Let's Assess

 	 What method should be used in the writer to give space from the left margin for the second 
paragraph of the essay prepared by Raheem?

	 a) Footer                         	 b) Insert Page Number

	 c) Header                        	 d) Indent

	 In the magazine prepared in a word processor, the name should appear at the top of every 
page. Which of the following methods is most suitable for this?

	 a) Header 			   b) Footer   

	 c) Before Text Indent    	 d) First Line Indent

	 How to give a yellow background colour to the header of a table prepared in LibreOffice 
Writer?

	 a) Select Table Cell Background Color on the Table toolbar.

	 b) Select Borders on the Table toolbar.

	 c) Select Background Color in the Paragraph tab.

	 d) Select Character Highlighting Color in the Character tab.

Extended Activities

1.	 Prepare an essay on atmospheric pollution in LibreOffice Writer for a seminar to be presented 
at school on World Ozone Day. Format the paragraphs, include a header and footer, and print 
the essay.

2.	 Prepare a list of various Costumes (Veshangal) in Kathakali, their characteristics and 
features, in LibreOffice Writer and make it attractive.


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“ Where words fail, music speaks .”
                                              - Hans Christian Anderson

You have used audio editing software in previous classes to 
record and edit audio on a computer. But have you heard about 
a system that helps to create music using a computer? 

Chapter 3

Digital Music

One factor that makes movies and plays attractive is the background music. This gives more 
power to the performances of the characters.

Early films were silent films. With the development of technology, cinema has become an art 
form that constantly amazes us through the combination of art and technology.

How is background music created for movies and animations?

One method is to create background music by playing and recording musical instruments. 
With the advent of digital technology, computers and related software began to be used for 
this purpose..
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DIGITAL AUDIO WORK STATION

Digital Audio Workstation (DAW) is an application software used for recording audio, 
editing, and creating music.

DAWs are also used for activities such as preparing sound tracks for radio and television 
programs, and adding sound effects to podcasts.

Cubase, FL Studio. Logic Pro, LMMS, Studio One, Pro Tools are examples for DAW 
applications.

Fig. 3.1 DWA Application Window

If we have  such a system, we can create music ourselves for 
any of our needs. Isn’t it?Such software that helps create music 
on a computer is called a Digital Audio Workstation (DAW).

Watch the video named Animation.mp4 included in the School_
Resources/Class_8 folder on your computer.

This animation was prepared without adding background 
music,wasn't it?
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LMMS (Linux Multimedia Studio), a digital audio workstation 
software available under a free license, is available on our 
computer. How about creating background music for this 
animation video using it?

Let's Get Acquainted with LMMS.
Open the LMMS software on your computer and examine all 
the techniques arranged in the window for creating music.

When you open the LMMS application, the sub-windows 
Song-Editor, FX-Mixer, and Controller Rack can be seen along 
with the toolboxes (Figure 3.2).

Fig. 3.2 LMMS Application Window

Since the FX-Mixer and Controller Rack in the window are not 
needed now, you can close them.

The Song-Editor, which is the main sub-window of the 
LMMS software, is shown in Figure 3.3. Four tracks like 
TripleOscillator and Sample track are available in it. These 
tracks can be removed by clicking on the Action button. If new 
tracks are needed, they can also be added from the Sidebar.

Song-Editor

Controller Rack

Fx-Mixer
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Tracks in Song-Editor Window

Action Button

Fig. 3.3 Song- Editor Window

Like the Song-Editor, other tools we need are arranged in some 
other sub-windows. To make these sub-windows visible, you can 
use the tools in the Window Controls tool bar (second row) shown 
in Figure 3.4. Click on the tools and observe the new windows 
appearing. If you want to remove the appeared windows, just 
click on the same tool again.

File ControlsFile Controls

Window ControlsWindow Controls

Side BarSide Bar

Fig. 3.4 Menu Bar in LMMS Window
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How to Arrange Rhythm
	� Open the Beat+Bassline Editor sub-window by double-clicking on the Beat+Bassline track 

in the Song-Editor window or by using the toolbar.

	� In this window, a track for one instrument is available. Create the rhythm by clicking on 
the blocks in this track according to the desired rhythmic pattern.

	� Use the Play button in the same window to play the created rhythm.

Let’s Create Rhythm
You know that background music includes melody and rhythm. 
Usually, instruments like tabla, maddalam, chenda, etc. are used 
for rhythm and instruments like veena, violin, etc. are used for 
melodies. Using LMMS software, you can create melodies and 
rhythms similar to those produced by these instruments. 

Shall we check it?

Let's see how to create a rhythm for the background music of 
the animation video we saw. 

For that, open the School_Resources folder and watch the 
Animation.mp4 video once again. Discuss with your friends 
and decide on a rhythmic pattern for the background music.

Let us examine how this rhythmic pattern would be using the 
LMMS software. You can also edit it if it is not correct.

To add rhythm, the Beat+Bassline track in the Song-Editor 
window is to be used.

The rhythm we found should be arranged in this track. Try 
arranging a rhythm in the Beat+Bassline track as shown in 
Figure 3.5.

Fig. 3.5 Beat+Bassline Editor
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Didn't you create a short rhythm on the computer? Now 
Listen to the rhythm you created using the Play button in the 
Beat+Bassline Editor window.

In the TEMPO/BPM  section at the top of the main 
window, the speed (Tempo) of the rhythm we created should 
also be set to 120. 

You can check this by hovering the mouse pointer over this 
tool and scrolling the mouse.

Right now, we created the rhythm using only one percussion 
instrument. What if we need to create a rhythm with more 
percussion  instruments together? For this, new percussion 
instruments need to be added to the Beat+Bassline Editor.

You will get more percussion instruments by clicking on the 
My Samples tool in the Sidebar (Figure 3.6).

When Creating an 
LMMS Project

When creating a project in 
LMMS, the speed (Tempo) 
and rhythm process (like 4/4, 
3/4, 6/8, 7/8...) need to be 
adjusted accordingly.

Fig. 3.6 My Samples in the Sidebar

In the Beat+Bassline 
Editor, you can remove 
blocks by clicking on 

them again.
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How to Add a New Instrument in the Editor

	� Click on the My Samples tool in the Sidebar.

	� From the options that appear, select the folder of the required instrument.

	� From the listed instruments, double-click on the instrument you want to add. 

	� With this, a track for the new instrument will be added in the Beat+Bassline Editor window.

Open My Samples → drums and from the list within it, try 
adding the instrument named 'kick01' to the Beat+Bassline 
Editor window as shown below:

Didn't you add kick01?  Now, the rhythm for this instrument 
should be created by clicking on the boxes in the track. Then, 
listen to the new rhythm.

Now, by adding more instruments, try creating and playing a 
rhythm in the Beat+Bassline Editor following the model shown 
in Figure 3.7. You can find the names of the instruments to use 
by looking at the picture, right?

 Fig. 3.7 Rhythm Arranged in Beat+ Bassline Editor

As soon as you close the window where you created the rhythm 
in this way, this rhythm will be arranged in the first block of the 
Beat+Bassline track in the Song-Editor window.

With this, you can create the necessary blocks of this rhythm 
by clicking on the timeline to the right of the track.

Now, create the rhythm by clicking on the blocks according to 
the instructions given in Figure 3.8.
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Fig. 3.8 Rhythm Organised in Song Editor

Timeline

This Block is repeatedly accessible 
by clicking the same block.

The first block where rhythm is available

Didn't you create the rhythm? You can save your work so far 
using File → Save.

Let's Compose Melody
The rhythm needed for the background music is ready. Now 
let's create the melody to go with it.

This should be prepared keeping in mind the rhythm that 
matches the transitions in the animation 
video and its timing.

To create the rhythm, the first thing to do 
is to determine the musical instruments 
that will work in the background.

For this, find the tone named 'dong03' 
from 'misc' in My Samples and drag it 
to the Song-Editor window (Figure 3.9).

Now, to add the rhythm we decided on 
to this, open the Piano-Roll window by 
double-clicking on the first block of this track in the timeline 
(Figure 3.10).

Using the mouse, you can add the melody in this window either 
by playing the keyboard on the piano or by clicking on the 
timeline.

Fig. 3.9 When New Tone was Added to the Song- Editor

The tone dong01
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     If using a keyboard, the record button in 
the Piano-Roll window is to be pressed.

Fig. 3.10 Piano- Roll Window

Record

To record while listening to other tracks

Fig. 3.11 Record Buttons in Piano- Roll Window

By playing the animation video, can you record the tune until 
it’s perfect? You can use right click to delete mistakes.

Haven't you created your own tune for the animation 
movie ?

The tune prepared by the student Ayona is given in Image 
3.12. Try creating this tune in the Piano-Roll according to the 
instructions in the image.

To Delete from 
Song+Editoryou can use  
Right Click → Delete.
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Fig 3.12 The Melody Created in the Piano-Roll with Indications

In the Song-Editor window, click and add this music for as 
long as  it is needed.(Fig 3.13)

Fig. 3.13 After Adding Music in Song- Editor Window

Have you listened to the background music you created? You 
can add more instruments and make the music more melodious.

After completing all the work, you can export it to any audio 
file format using File → Export.

I have created tune 
in G-Compris.
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Let’s Assess

1.	 How do you delete blocks created in the Song-Editor window of LMMS software?
			  a) Right Click			  b) Left Click
			  c) Scroll Wheel Click		 d) Double Click

2. Right Click b) Left Click c) Scroll Wheel Click d) Double Click
			  a) Right Click			  b) Left Click
			  c) Scroll Wheel Click		 d) Double Click

3. How do you delete music notes created in the Piano-Roll window of LMMS software?
			  a) You can create independent music with it.
			  b) You can add music to video with it.
			  c)You can add music to animation with it.
			  d) You can read text files with it.

4.  What action should be taken to increase the tempo of music notes created in LMMS software?
			  a)  Increase BPM	 .		  b) Decrease BPM.
			  c)  Increase Time signature		  d) Create more blocks in Beat Editor

5. 	Which Tool in LMMS software helps to select Music Tones (Musical Sounds)?
			  a) My Samples			   b) My Projects
			  c) My home			               d) song editor

Extended Activities

1.	 Open the file named "Music1.mmpz" from the "School_Resources" folder in LMMS, create 
a rhythm for the music you get, and export it.

2. 	Using LMMS, create a login music that you will hear when you log in to your computer. 


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Do you know who is in the picture?

He is the first Indian to win an individual gold medal in the Olympics.

In 2008, at the Beijing Olympics, 
he achieved this feat in shooting.

This is a picture of Abhinav 
Bindra, whom our country has 
honoured with awards like the 
Padma Bhushan and the Arjuna 
Award.

Have you watched shooting 
competitions?" 

There are various types of 
shooting events, including rifle, 
pistol, shotgun, etc.

The double trap competition in the shotgun category involves 
shooting at two targets that are launched into the air and scoring the 
maximum possible points (Figure  4.2).

India has also won a medal in this event at the Olympics. You 
should find out who won it.

Fig. 4.1 An Indian Sportsman

Chapter 4

Computer Games
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Fig.  4.2 Double Trap Shooting

A digital version of the 'Double Trap Shooting' competition is 
available as a game on your computer.

Open the file named 'double_trap.html' in the School_Resources 
folder at home, click on the green flag, and try playing the 
game (Figure  4.3).

Didn’t you like the game?

The game is about hitting the target as many times as possible 

Fig.  4.3 Double Trap Shooting – Game Window
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Stage and Sprite

In Scratch, when creating games or animations, the 
characters or objects that need to be included are 
called sprites. Through instructions, sprites can be 
given movement, appearance, and sound, making them 
functional.
The stage is the background for the game to run. By 
including various backdrops on the stage, the game layout 
can be made attractive.

Game Assets

All the resources used to 
create and enhance the visual, 
auditory, and functional 
aspects of a game, including 
images, animations, sound 
effects, music, 3D models, 
and scripts, are considered 
game assets.

with the 20 bullets provided.

Let's see how the game works.

	� After clicking the Green flag, the gun turns towards the 
mouse pointer as you move the mouse.

	� The balloons (targets) rise from the bottom to the top. They 
rise from different places in different directions.

	� When the game starts, twenty bullets are available. The 
score is zero.

	� When you click on the game screen (Stage), the bullets travel 
towards the mouse pointer. Along with this, the number of 
bullets in your stock decreases.

	� When a bullet hits a balloon, it bursts. The score increases.

	� The game ends when all twenty bullets are used up.

So, you've understood how the game works. This game was 
created using Scratch, a block programming technique you 
learned in previous classes.

Shall we try creating a similar game using Scratch?

Let's see what all game assets are needed for this.

	� Background for the shooting range (backdrop).

	� Sprites like the gun, balloon, and bullet.
	� Instructions/Coding for the 

sprites to function correctly.

Now, let's start making the game.
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What all needs to be done for this?

	� Backdrop and sprites should be arranged in the game 
window.  

	� Set up the necessary costumes for the sprites.

	� Prepare the code blocks needed for each sprite to function.

Scratch is familiar to everyone, isn't it? (Figure 4.4)

Fig. 4.4 Scratch Window

The image shows Dango, the current sprite in Scratch 4.5. 
Since this character is not needed in our game, open the Scratch 
window and delete it.

Let's make the background

To make background (Backdrop) needed for the game, click on 
the Choose a Backdrop option in Stage (Figure 4.6) and select 
the backdrop named Blue Sky <image>  from the Scratch 
library.

With this, the background for the shooting range is now ready 
(Figure 4.7).

Fig. 4.5 Dango Sprite



Computer Games

49 Information and Communications Technology-VIII

Fig. 4.6 
The Window for Adding a Backdrop

Figure  4.7 When a New Backdrop is 
Added in Scratch

Let's Draw and Add a Gun
The next thing to do is to include the image (Sprite) of the gun 
for the competition. Shall we draw and add the gun ourselves?

You can draw a picture in the window that opens when you 
click the Paint option (Figure  4.8).

In the Paint window, use the Rectangle tool to draw a gun as 
shown in the picture. After that, give this sprite the name "gun" 
and set its size to 50 (Figure  4.9). Fig. 4.8. Paint Option in Scratch

Fig. 4.9 When a New Sprite is Drawn

You've drawn and added the sprite. Now, arrange the position 
of this sprite as shown in the picture. (Figure 4.10)

Color

Rectangle Tool
Name of Sprite

Size
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Fig. 4.10 Position of the Gun Sprite

Gun

Let's Give Movement to the Gun
How should the gun work?
	� After clicking the green flag, the gun should turn towards 

the mouse pointer as the mouse is moved. 

To make the gun turn towards the mouse pointer, you can use 
the  block from the Motion section.

  

This activity is to be done continuously. We 
know that we can use the "forever" block for this. 
Therefore, let's give the gun sprite the codes as 
shown in the picture (Figure 4.11).

Now click the green flag and try moving the 
mouse.

The sprites we need next are the balloon and the 
bullet.Fig. 4.11 The Instructions for the Gun to 

Follow the Mouse Pointer

Is the activity 
saved?
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The sprite we need for the bullet isn't available, so let's draw 
it ourselves. Using the Rectangle and Reshape tools, draw a 
bullet as shown in Figure 4.12

Fig. 4.12 When Bullet is Drawn

After setting the bullet's size to 10, place it in the middle of the 
gun's barrel. (Figure 4.13)

Fig. 4.13 Position of Bullet

The bullet we have drawn will now be on top of the gun. You 
can click on the gun sprite once and move the bullet behind it.

Instead of this, can we move the bullet behind using code 
blocks? Try it out 

Which are the blocks 
in Scratch 

for giving instructions
 to repeat an action?

Reshape Tool
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To Add Balloons
The "Balloon1" sprite is available in the Scratch library itself. 

Using the "Choose a Sprite" option (Figure 4.14), try adding 
two balloons to the window. (Figures 4.15 and 4.16).

Fig 4.14 Choose a Sprite Option

Fig.  4.15 Balloon 1 Sprite in Scratch Library

Fig.  4.16 When Two Balloons are Added

We've added the balloons.

Which colours of balloons do we need?

	� Blue and yellow.

Right now, you have two blue balloons. 

To make the second balloon (Balloon2) yellow, go to the 
Costume section, keep the yellow balloon costume, and delete 
the rest. Then, adjust the size of both balloons to 50.

The balloon needs to change its appearance when it's hit by a 
bullet, right?

Let's see how to do that.
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To change the look of sprites, we usually change the Costume.

Here, since we don't have a suitable costume for a bursting 
balloon in the Scratch library or readily available, let's draw 
one ourselves.

To do this, right-click on the existing balloon sprite's image in 
the Costume section and select "duplicate" (Figure 4.17).

Then, using the Reshape tool (A), change this into a bursting 
balloon (Figure 4.18).

Fig. 4.17 Duplicate Costume

Fig. 4.18 When the Shape of the Sprite is Changed

To give animation
effects to sprites, 
just change their 

costumes.
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In the same way, a costume is to be added for the yellow balloon 
as well.

With this, the sprites needed for our game are ready.

Now, let's prepare the instructions needed to make them work.

Have you tried running the game (double_trap.html) in the 
School _Resources folder?

 In this game,

	� Firing happens when the mouse is clicked on the stage.

	� Initially, 20 bullets are available. 

	� The bullet travels in the direction of the mouse click.

	� Each time you fire, one bullet decreases.

	� When the bullet hits the balloon, the score increases.

To implement these, 

	� Let's create variables named 'bullets' and 'score'.

Create these variables in your project using the 'Make a 
Variable' option in the variables section ( Figure  4.19).

Fig.  4.19 Window for Creating Variables

Variables

Variables are techniques used 
to temporarily store numbers, 
texts, etc.,

 which are needed for a 
program to run and whose 
values can be changed.



Computer Games

55 Information and Communications Technology-VIII

You have created variables named bullets and score, haven't 
you?

To set the number of bullets to 20 and the number of hits (score) 
to zero when the game starts, prepare the gun sprite's code as 
shown in the picture (Figure 4.20).

Let's Fire
Firing should happen when the stage is clicked, right?

That is, when the bullet sprite receives the message that the stage 
has been clicked, it should quickly move to the clicked location. 

In Scratch, to exchange information between one sprite and 
another, you can use the broadcast message block.

Let's create a message named "Clicked" and broadcast it. 

Create a broadcast message by selecting "New message" in the 
broadcast block (Figure 4.21).

Fig.  4.20 Codes to Set Bullets and 
Score at the Start of the Game.

Fig. 4.21 The Steps to Broadcast Message

You know that this should only happen if the gun has bullets. 

For this, let's give the stage the code as shown below 
(Image 4.22).

Fig.  4.22 Program Codes to Broadcast Message

The whistle is blown. 
Let’s start the game

A message broadcast 
by one sprite  can be received 
by more than one sprite at the 

same time.
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Clones

Using the "make a clone" block, 
you can create clones of the same 
sprite. 

The operational codes for the 
created clone sprite should be 
included in the "when I start as 
clone" block.

This is very useful for creating 
sprites with the same 
characteristics.

What should happen when the "broadcast message" (the 
message that says "clicked on stage") is received by the Bullet 
sprite?

	� The Bullet should move towards the clicked location.

At the same time, new bullets should appear every time the 
stage is clicked, right?
But here, only one bullet is added. Then how can we fire 
multiple bullets?
For this, we can use the "clone" feature. "Clone" is a feature 
in Scratch that is used to create multiple sprites with the same 
characteristics and behaviour as one sprite.
That means here,

	� When the message "clicked on stage" is received, the bullet 
should reach the barrel of the gun and a clone of it should 
be created.

	� The cloned bullet should move towards the clicked location.
	� The bullet should move until it hits the edge of the stage. 
	� The number of bullets should decrease by one as soon as it 

is fired. 
	� Along with this, there should be a sound when the bullet is 

fired.

To add a sound to the bullet:

	� Select the bullet sprite, open the Sound window, and from the 
Scratch audio library, add the sound "Rip" using the "Choose 
a Sound" option (Image 4.23). (Image 4.24)

Fig.  4.24 Scratch Audio Library Window

Fig.  4.23 Choose a Sound Window
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Give Codes to the bullet sprite as shown below and try running 
it. ( Figure 4.25)

Fig.  4.25 Codes for the Bullet

When you click, the bullet should move with a sound to where 
you clicked on the stage, right?

Now, analyse the code blocks provided in Table 5.1, determine 
the purpose of each block, and record it in the table.

To decrease the value of the 
'Bullets' variable by one

Table 4.1 Function of thCodes Used in the Program

What else is needed to finish the game?

	� When the green flag is clicked, the balloons should rise from 
the bottom to the top.

	� They (the balloons) should start from different positions.

Don't forget to delete 
the clones once their 

function is over.
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	� As the bullet hits the balloon,

	� The balloon should crash. 

	� A sound should play. 

	� The bullet should disappear.

	� The score should increase by one.

Raising the Balloon

The position of a sprite is determined by its x and y values.

That is, if the x value is gradually increased, the sprite will 
move from left to right. As the y value increases, it will move 
from bottom to top.

To make the balloon rise from different places, it is enough to 
change its x value to a random number between -230 and 230. 
For that, you can use the block 

Since it has to rise from below, the y value can be given as 
-107.

To make the balloon rise upwards, we can add the glide block 
as well. ( Figure 4.26)

Random Numbers

In Scratch, the pick random 
block can be used to get any 
value between two given 
values randomly. Each time 
the pick random function runs, 
it will return different values 
within the specified range

Fig.  4.26  Code for the Balloon to Rise Randomly from Different Places
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Fig.  4.27 When the Bullet Hits, the Balloon Bursts, 
Causing a New Balloon to Appear

What is to be done to 
get more than 1 score 
if the balloon bursts?

Now, find out why the y value is given as 165 in the glide 
block.

Let's Complete the Coding
Let's also include the code for the balloon to change costume 
and disappear when it touches the bullet, and to make a popping 
sound.

	� The popped balloon costume can only be seen if we wait for 
a while.  

	� After the wait, the unpopped balloon should reappear.

	� No separate sound needs to be added for the balloon. The 
sound 'Pop' is already included as the default sound for the 
balloon sprite.

The necessary codes for this are given below (Figure 4.27).
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Try running the game by adding these codes.

Currently, only one balloon is working. You can complete the 
game by giving the same code to the second balloon.

To give the code block given to one sprite to another , simply 
drag the code to the second sprite.

When dragging and dropping like this, don't forget to change 
the Costume names of the second balloon in the code.

Let’s Assess

1. 	Which block is used in Scratch to exchange information between two sprites?
			  a) Broadcast Message		 b) Create clone
			  c) Repeat until			  d) Forever

2. 	What is the technique that can be used in Scratch to create more than one sprite with the 
characteristics of one sprite?

			  a) broadcast			   b) clone
			  c) repeat unitl			   d) point towards

Extended Activities

1.	 Modify the created game so that it displays that the game is over when the number of bullets 
becomes zero.


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Have you heard the story of keyboard cat?
Fatspo is an orange coloured tabby cat. The video of this cat playing the keyboard was 
recorded by its owner, Charlie Schmidt, in 1984.  20 years later, when YouTube became 
popular, Charlie Schmidt uploaded it with the name Keyboard Cat. The video went viral, 
became a meme, and also an Internet sensation.

But Fatspo was not lucky enough to know any of this fame !

The cat passed away three years after the video was recorded.

Am a cultural idea or 
image that goes viral.

Anything that spreads 
rapidly in cyberspace 

can be called my name.

Chapter 5

Internet : A Boundless Realm of Knowledge 
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The viral success of Keyboard Cat later helped shape YouTube 
as a platform for sharing creative and entertaining videos.

Such is the story of Moo Deng, a hippo who is now part of a 
popular video game theme collection.

The reason for even small, ordinary moments become big news that is discussed 
worldwide is the Internet.

Open any web browser on your computer and search the 
Internet for Moo Deng.  (Keyword – Moo Deng)

What did you get when you searched ?

	� Images

	� News

	� ...............................................................................................

While searching on the Internet
Check how many websites had the details about Moo Deng 
among the results obtained when you searched.

You will see that these websites contain not only text but also 
images, videos and animations.

Click on any of the images that you find when you search. This 
takes you to the web page that contains the image. This is one of 
the many ways to surf the internet. As information technology 
advances, the facilities on the internet are also increasing.

Imagine a huge network that connects billions of computers 
around the world. In simple words, this is the internet! It is like 
a large digital repository, where we can access the information 
available there anytime, anywhere. Moreover, it is also a huge 
computer network that provides an environment for people 
around the world to communicate and share information.  
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It is a gigantic web of crores of devices ranging from smart 
phones to  super computers

Web
Web is acronym of World 
Wide Web (WWW).  It is a 
proper arranged repository of 
inter connected web pages and 
web sites available through the 
internet. 

The History of Internet
'Haven’t you heard that ‘necessity is the mother of invention’?  
The origin of the Internet has such a history. You know that 
the competition that developed between the United States and 
Russia after World War II is known as the Cold War. During 
the Cold War, countries were afraid of nuclear attacks on each 
other.

They knew that a nuclear attack would destroy their 
communication systems and also the defence and infrastructure 
of the country.  Therefore, countries turned to efforts for creating 
a strong communication network. Thus, the American defence 
agency created a computer network ARPANET (Advanced 
Research Projects Agency Network).  This is considered the 
first public network.  The evolution of the Internet continued 
with the development of the World Wide Web in the late 1980s. 
Information could be accessed and shared much more easily 
through hyperlinks.

Let’s examine the major milestones in the history of the Internet 
via the infographics given in Figure 5.1.

Internet is not just 
for searching

There are countless 
creative spaces 
like e-learning, 

entertainment, etc.

Online shopping, 
telemedicine – 

everything is here.

It has 
communication
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So now it is clear that many of the Internet systems we use today 
have reached their current state after continuous research and 
evolution. It can be seen that our Kerala has also contributed 
to these changes made in information technology at the global 
and national levels.  

Complete Table 5.1 below based on the information given in 
the infographics in Figure 5.1. If necessary, use the Internet for 
more information.

Description Name / Year

Name of the systems such as Google and Bind that are used to find 
information on the Internet

Search Engine

The year in which India became a part of the global Internet network

The first Indian state to declare ‘Internet – Citizen’s right’

The year in which Indian IT Act came into force

The technology based on which the tools like ChatGPT, Gemini, 
Deepseek etc., revolutionized the Internet.

Table 5.1 Some Basic Information Related to Internet

Fig. 5.1 Major Milestones in the Growth of Internet

Internet – Milestones of Growth

1969 1990 2000 2020

1969: ARPANET came into 
existence

1970: Vint Cerf and Bob 
Kahn developed TCP/IP

1986: email was introduced 
in India 

1989 : Tim Berners-Lee’s 
idea of www (a vast network 
for sharing information via 
the Internet)

1991 : World’s first webiste

1993 : The first web browser 
Mosaic was launched.

1995 : Internet becomes 
public in India.  Amazon, 
eBay in vogue.

1998 : The search engine 
Backup became Google.

1997 : The first standard 
Wi-Fi was introduced.

2000 : IT Act came into existence 
in India.  Social media, 
eCommerce etc., in vogue.

2002 : Akshaya project 
launched in Kerala.
2016 : A system for making 
payments using smart phones 
launched by the Government 
of India  - Unified Payment 
interface came into existence

2021 : Kerala Government's 
plan to ensure internet for all - 
K Phone

Crypto currency, IoT, 
Cloud computing

AI techniques became 
famous

Efforts to use satellite 
systems to bring internet to 
every corner of the world

Metaverse, 5G, 6G

1971: Ray Tomlinson 
developed email
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Computer Networks
Computer networks are systems that connect two or more 
computing devices to perform tasks such as communication, 
sharing resources, and exchanging information.   In this, virtual 
devices such as computers, smartphones, smartwatches, ATMs, 
and printers can be connected as links.   Each device that is a 
link is called a Node.

Special rules and technologies are used to communicate 
between nodes and share files and resources. This is called a 
Network Protocol.

Terms related to Internet
As the Internet has become a part of our daily lives, we have 
started using many terms related to it in our speech and writing.  
Can you prepare a list of technical terms related to the Internet 
such as webpage, smart TV, HTML etc.,? Write down their 
usage.

While diving into the flood of information
You know that the Taj Mahal built by Mughal Emperor Shah 
Jahan in Agra has been the inspiration for the creations of 
many writers.  Rabindranath Tagore described the Taj Mahal 
as ‘a teardrop on the cheek of time’.  

When a student Kanchana 
searched for the phrase 'Famous 
quotes about Taj Mahal' on her 
computer using the Google 
search engine, the results 
obtained were as given in Figure 
5.22. Fig. 5.2 A Google Search Result Page

There are some sections that appeared when the said phrase was 
searched. For example:- Gooreads, instagram etc. However, if 

There are many ways 
to use the internet, like 

browsers, apps, software, 
IoT, and gaming 

consoles.
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we search only for the name Taj Mahal, many of these may not 
appear, and instead some others may be displayed. The search 
engine understands the intention of our search terms (Search 
Queries) by examining them (Intent Recognition), and the 
search engine provides the search results accordingly.

The results of two different search engines for the same search 
terms are given in Figures 5.3(a) and 5.3(b). Observe the 
figures and complete Table 5.2.

e-Reading

There are many popular 
social websites for writing 
about books and sharing your 
enjoyment. Examples include 
Goodreads, StoryGraph, Book 
Riot, and Open Library. They 
offer a variety of features, 
including author profiles, 
lists of books read, and book 
recommendations.

Figure 5.3(a) Figure 5.3(b)

Search term How astronauts stuck in  
space station?

Search engine Google

Specially features sections
Copilot, 
Videos, 

Images,...
Image, news, video, map 
എന്നീീ വിിഭാാഗങ്ങളുുടെെ ലക്ഷ്യംം�

Other observations

Table 5.2 Results from Different Search Engines

Fig. 5.3(a) Google Search Results
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Fig. 5.3(b) Bing Search Results

Is the table complete ? Different search engines use different 
techniques to provide the answers we need. Examples of this 
are the results that appear first as part of the search, and content 
that is combined from data collected from different websites 
according to a search term. These are called search snippets. 
Such content is created using artificial intelligence.

Search engines consider many things when providing search 
results. The relevance and quality of the content, the location 
of the search, the interests of the searcher, and many more. 
While it is important to deliver content to us with greater 
accuracy, there are also various business and political reasons 
for prioritizing private websites. We saw different websites 
enlisted by different search engines for the same search term. 
This difference becomes more apparent if a more vague search 
term is given.

After searching for a tour, 
the ads and news on the 
phone are  all related to 

trips.
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Collect Only What is Needed
There is a lot of information about each fact on the Internet. In 
order to select only the information we need from this flood of 
information, it is important to provide a more specific search 
phrase. There are some other ways too. Let's examine some of 
these given in Table 5.3.

Search methods Example for search 
phrase

How it works

Use words like AND, OR, NOT  
etc.

Climate change AND 
renewable energy NOT 

fossil fuels

Includes pages in which climate 
change and renewable energy are 
mentioned and excludes those that 

mention fossil fuels.

Enter search phrases in quotation 
marks (" ")

“water cycle process”

Only pages that contain the phrase 
will be included in the search 

results.

Use a '-' symbol before specific 
words

Internet as a fundamental 
right -Kerala

Search generally on the topic but 
excludes those that mention Kerala.

Enter a period
The Diary of a Wimpy Kid 

Reviews 2024
Results will be limited to a 

specified time period.

Table 5.3 Different Ways for Effective Search

Search and Find
Using the information given 
in Table 5.3, find the details 
about the Nobel Prize in 
Physics and Chemistry for the 
previous year only.

Usage Rights
Have you understood that all information published in digital 
spaces cannot be used by everyone?  Many of them have legal 
and ethical restrictions. For example, some information on the 
official websites of the Department of Public Education may be 
available only to the Headmasters. Websites and mobile apps 
may also have security features such as User ID, Password, OTP, 
etc. to share information only with selected users.
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Given below is a list of information published publicly on the 
Internet and information restricted to specific users. Discuss  
with your friends and complete it (Table 5.4).

Category General Information Restricted information

Finance
Price details, financial 

packages, company’s annual 
reports

Personal account information, 
credit card number, PIN, ...

Health Information about epidemics, 
use  of medicines, ..... Patient’s medical information, ...

Education Some official documents, personal 
information, ....

Social Media

Table 5.4 General Information and Restricted Information on the Internet

See Figure 5.4.  Have you seen this kind of news ?

Fig. 5.4  An Online News

The above news is about a crime under the copyright law.

However, is making a pirated version of a movie the only type 
of crime in such cases? Certainly not.  Viewing and sharing 
such resources are also crime.
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The usage rights of images, videos, songs, software etc., have 
been defined as an intellectual property rights. These rights 
determine who owns the content, how it can be used, and what 
limitations there are.      

When using content from the Internet, it is essential to consider 
such rights. Otherwise, it may lead to legal consequences. 
Check if the websites you visited in previous activities have 
provided a warning message like the one shown in Figure 5.5.   

This is a statement indicating that all exclusive rights granted 
under copyright law are reserved for the creator of the content. 
This means that others cannot use, reproduce, or modify such 
works without the express permission of the owner. Some of 
the most common usage rights are given below.

	� Copyright : This is the legal protection to the original creators 
for their work. It guarantees the owner exclusive rights to 
distribute, reproduce, perform, and display his work. For 
example: A poet has full rights to his poem. No one else can 
use it without his permission.

	� Copyleft : Copyleft is a licensing approach that ensures the 
freedom of users to use, modify, and distribute works freely. 
This is a key principle of the open source movement. For 
example, the Ubuntu operating system used on our school 
laptops is released under the GNU General Public License 
(GPL).

	� Creative Commons License : A license that allows creators 
to distribute their work in a variety of ways. This includes 
allowing free use and distribution, requiring attribution, and 
prohibiting commercial use. For example, content published 
on Wikipedia.

	� Fair Use : Allows limited use of copyrighted material for 
educational, critical, and research purposes, subject to certain 
restrictions. Ex:- The practice of publishing short clips of the 
copyrighted movie in news related to its release.

Fig. 5.5  Copyright Indication
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Really marvellous! 
Ensure the copyright 

of it.

Understanding Usage Rights
Any content found by searching on the Internet can be used 
only after checking its license. Major search engines provide 
special tools to check this.

Look at Figure 5.6. The window shown in the figure is the 
one that appears when you search for an image in the Google 
search engine and select  Tools → Usage Rights.

Fig. 5.6 Filtering Search Results in Google

It took hours to draw 
this.  Shall we publish 
this in social media ?

AI Generated Image
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This is the window to filter search results. Examine the 
difference in search results when selecting other licenses 
related to usage rights.

Now, search for images in different categories such as Creative 
Commons License Photograph, Clip art, Line drawing, etc. 
using search engines like DuckDuckGo, Bing, and Yahoo 
Search. You can use the search keywords given below. 

	� Satellite View of Earth

	� World's Oldest Trees

	� Architectural Marvels of India

Evolution of the Web
There have already been many changes in the Internet systems 
and the ways in which they are used. Based on this, the evolution 
of the Web can mainly be classified into different generations 
such as Web 1.0, 2.0, 3.0, and 4.0. This classification is based 
on technological advancements, user interaction capabilities, 
and the overall purpose of the Internet at each stage. Figure 5.7 
shows the characteristics of each of the web evolutions.

Evolution of Web

Web 1.0 Web 2.0 Web 3.0 Web 4.0

Static 
Web

Interactive 
Web

Sematic 
Web

Intelligent 
Web

Fig. 5.7 Evolution of Web

	� Static websites with 
hyperlink connectivity 
alone.

	� Limited interaction 
with the users, 
customisation

	� Only publishing 
the information is 
important 

	� Dynamic websites, 
more interactive.

	� User generated 
contents, opportunities 
of interactions

	� E-Commerce, E-Blog, 
Social Media, Wiki

	� AI bases services

	� Search results as per 
the interest of the 
users

	� Emphasis on privacy

	� Smart assistants with 
a focus on privacy, 
person-based content.

	� Virtual and augmented 
reality, Internet 
of Things (IoT), 
Metaverse.

	� Integration between 
the real world and the 
cyber world.

	� Emphasis on 
emotional intelligence 
and predictive 
capabilities.
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Mobile Network
We know that internet can be accessed using various 
gadgets without computers. The ability to connect to 
the internet using smartphones has brought about great 
changes in human life. Similarly, e-SIM system is now 
common in smart watches and laptops. The main reason 
for this is the growth of mobile networks. Let us examine 
the evolutions in the field of mobile communication given 
in Figure 5.8.

eSIM

eSIM is a digital SIM card built 
directly into a device. Unlike 
traditional SIM cards, it allows 
you to use a mobile plan from 
your service provider without the 
need for a real SIM card.

Smart Assistant
World-renowned physicist Stephen Hawking suffered from 
Amyotrophic Lateral Sclerosis, a disease that damages the 
brain and spinal cord. Due to this, he had great difficulty in 
walking, speaking and breathing.  However, through the use of 
advanced technology, he could overcome them and make great 
contributions to physics. Search the Internet to find out about 
the device specially designed for him.

Information technology is being used effectively today to make 
life easier for people with disabilities and to showcase their 
abilities. Assistive tools are technological systems designed to 
help people, including those with disabilities, use computers, the 
Internet, and related devices. See Table 5.5 for some assistive 
tools and their uses.

2G

3G
4G 5G

6G

Voice Calls

SMS, MMS

Mobile 
Internet

Data speed 
increased for 
mobile internet 
and calls.

Web browsing, 
Gaming

High-speed 
data for 
HD video 
streaming and 
online gaming

Support for 
IoT, autonomus 
vehicles 
and AR/VR 
applications.
Ultra high 
speed

Ten times 
faster than 5G, 
more coverage 
and sage.

Mobile Technology Generation

Fig. 5.8 Mobile Technology Generation
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Tools Uses

Screen reader Software that reads aloud the sentences on screen for 
the visually impaired.  For Example – Orca, JAWS (Job 
Access With S[eech), NVDA (Non-Visual Desktop Access), 
VoiceOve (Mac)

Screen Magnifier Software that enlarges text and images on the screen so that 
they can be seen more easily. Can be used by those with visual 
impairments. For example – Magnus, ZoomText, Windows 
Magnifier

Sub title tools Systems which help hearing impaired persons.  Provides 
captions for audio content.  For example – Aegisub, YouTube 
Automatic Captioning, Descriptive Video Services (DVS)

Real-Time Translators and 
Transcribers

Translates speech or text in real time for communication. For 
example – Mozilla DeepSpeech, Google Translae, Otter.ai.

Table 5.5 Assistive Tools

Virtual Assistants

Smart assistants are software that works on artificial 
intelligence and can perform various tasks. Virtual assistants 
can do many things, such as set alarms, call specific numbers, 
run music libraries, translations, searches, provide weather 
information, news, etc., control home appliances according to 
pre-set settings. Amazon Alexa, Apple Siri, Samsung Bixby, 
and Google Assistant are some of the virtual assistants.

Safe Internet Use

Collect the cyber-related news from the newspapers during the 
last month and categorize them as given below.

	� News related to new inventions in the IT sector.

	� Incidents of financial loss due to careless use of the Internet.

	� News about fake news on the Internet.

	� News about computer viruses.

	� News about the use of artificial intelligence.

	� ...............................................................................................

Check which category of news you have collected has the most 
news. 
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Internet is a very useful system for us. However, if it is not 
used carefully, it can lead to great dangers. Below are some 
necessary precautions for the safe use of internet.

Stay Safe Online
	� Use the internet only with the knowledge of parents.
	� Monitor cyber news in the media.
	� Use strong passwords on digital devices.
	� Be careful not to overuse digital devices.
	� Do not share passwords and OTPs with others.
	� Do not blindly believe everything you see online.
	� Use social media with utmost caution. 

Discuss about more precautions to be taken for safe internet usage 
in class and record them in your notebook. Furthermore, organize 
an awareness class on the topic 'Safe Internet Usage' for parents 
at the school, incorporating the points you have discovered.

Let’s Assess

 		 A licensing approach that ensures users are free to use, modify, and distribute works.

			  a) Proprietary  			   b) Copyright 			    
		 c) Fair Use  				    d) Copyleft

 		 Which category of software does a 'screen reader' belong to?

			  a) Virtual Assistant  			   b) Video Generation 

			  c) Assistive Tool  			   d) Web Browser

 	 How can you prevent someone from using a painting you created using Krita software (PNG 
File) as their own without permission?

			  a) Provide a warning against the use. 
		 b) Use a licensing system 
		 c) Make only the project file available					      
		 d) All of the above can be used.
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Extended activities

1.	 Using any translator on the Internet, translate two paragraphs from this textbook into 
English.

2.	 The icons of some of the systems we use regularly in connection with the Internet are given 
in the table.   Complete the table with at least one use of them.



Icon Name Concept

•	 Part of email addresses

•	 Used to mention the people in messengers

Hyperlink

Cloud Computing The remote servers for collecting and processing 
Internet data

@
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CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national 
struggle for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon 
to do so;

(e) 	to promote harmony and the spirit of common brotherhood amongst 
all the people of India transcending religious, linguistic and regional 
or sectional diversities; to renounce practices derogatory to the 
dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, 
lakes, rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry 
and reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and 
collective activity so that the nation constantly rises to higher levels 
of endeavour and achievements;

(k) 	who is a parent or guardian to provide opportunities for education 
to his child or,  as the case may be, ward between age of six and 
fourteen years.



CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in
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